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Chapter 1: Getting Started

Welcome
Congratulations on purchasing your Pocket PC. Its compact size and powerful features and
functions let you keep your most important business and personal information up-to-date and
close at hand. Microsoft® ActiveSync® increases the power of your Pocket PC by allowing you to
synchronize the information on your desktop or laptop computer with your Pocket PC. Picture
yourself in the following situations:
• While walking with a colleague, your cell phone rings and the boss asks if you two are free this

afternoon for an emergency meeting. While your colleague fumbles through his paper
organizer, you press a button on your Pocket PC and instantly see a list of today’s appointments
and meetings. You are quickly able to tell the boss your available times. For more information
on scheduling appointments and meetings, see Chapter 4.

• You’re meeting your friends tonight for dinner and a movie. You download the latest movie
information from the Internet to your desktop computer and then synchronize it with your
Pocket PC. At dinner, you pull out your Pocket PC and review your movie options with your
friends. For more information on downloading Web pages, see Chapter 6.

• A Calendar reminder alerts you that it is time to catch the bus. You grab your Pocket PC and
catch the bus just in time. Because ActiveSync keeps the information on your Pocket PC up-to-
date, you leisurely review your task list, make notes about the new books and CDs you want to
buy, and read and respond to e-mail messages. When you get back to the office, ActiveSync
transfers any task changes you made, your notes, and your e-mail message responses to your
desktop computer. For more information on ActiveSync, see Chapter 3.

Where to Find Information
This manual describes your Pocket PC hardware, provides an overview of the programs on your
Pocket PC, and explains how to connect your Pocket PC to a desktop computer, a network, or the
Internet. For instructions on setting up your Pocket PC, see the Quick Start Guide. For
instructions on installing ActiveSync, see the documentation accompanying the ActiveSync CD.
The following table is a guide to additional information to help you use your Pocket PC.

For information on:

Programs on your Pocket PC

Additional programs that can be installed on
the Pocket PC

Connecting to and synchronizing with a
desktop computer

Last-minute updates and detailed technical
information

Up-to-date information on Windows®-
powered Pocket PCs

See this source:

This User’s Guide and Pocket PC Help. To
view Help, tap  and then Help.

The Extras folder, located on the ActiveSync
CD.

The ActiveSync documentation or
ActiveSync Help on your desktop computer.
To view Help, click Help and then Microsoft
ActiveSync Help.

The Read Me files, located in the Microsoft
ActiveSync folder on the desktop computer
and on the ActiveSync CD.

http://www.microsoft.com/windowsce/
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How to Transfer Palm-size PC Data
If you are currently using a Palm-size PC and want to transfer your data to your Pocket PC,
follow this upgrade procedure.
1. Install Microsoft ActiveSync 3.1 on your desktop computer. For information on installing

ActiveSync, see the documentation accompanying the ActiveSync CD.
2. Synchronize your Palm-size PC with your desktop computer so that the information on your

desktop computer is current.
3. If you have files on your Palm-size PC that you want to transfer, such as Note Taker notes and

recordings, turn file conversion off in ActiveSync options so that the files stay in Pocket PC
format, and use the ActiveSync Explorer to copy the files to your desktop computer. For
specific instructions, see ActiveSync Help on the desktop computer.

4. Synchronize your Pocket PC with your desktop computer. This will update your Pocket PC
using the current data on your desktop computer (step 2).

5. Reinstall programs. Check whether new versions that have been optimized for the Pocket PC
are available.

6. Using the ActiveSync Explorer, copy the files you transferred to your desktop computer in
step 3 to your Pocket PC.

7. In ActiveSync, turn file conversion on again.
8. Enter your settings and connection information on the Pocket PC.

If you have offline folders in Inbox on your Palm-size PC that contain e-mail messages you want
to transfer to your Pocket PC, use this procedure.
1. Connect your Pocket PC to your desktop computer and then click Windows CE Inbox

Transfer on the Microsoft Outlook Tools menu.
2. Select Copy or move selected messages to your desktop computer and then click the

Browse button.
3. Select the offline folder that contains the messages you want to transfer to your desktop

computer and then click OK.
4. Click the Transfer button and select the folder you want to transfer the messages to or click

New Folder to create a new folder. Click OK to transfer the messages. Now you must transfer
the messages from your desktop computer to your Pocket PC.

5. In Inbox on your Pocket PC, tap Tools and then New Folder and create a folder for the
messages you are going to transfer.

6. In Outlook on your desktop computer, select the messages you want to transfer.
7. Connect your Pocket PC to your desktop computer and then click Windows CE Inbox

Transfer on the Outlook Tools menu.
8. Select Copy selected messages to your mobile Pocket PC and then click the Browse button.
9. Select the offline folder on your Pocket PC you want to transfer the messages to and then click

OK.
10.Click the Transfer button. The selected messages are moved to your Pocket PC.
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Chapter 2: Basic Skills
Learning to use your Pocket PC is easy. This chapter describes the basic concepts of using and
customizing your Pocket PC.

Pocket PC Buttons and the Stylus
Your Pocket PC has hardware buttons that control actions and scroll functions, and a stylus for
selecting items and entering information.
On the Pocket PC, the stylus replaces the mouse.
• Tap. Touch the screen once with the stylus to open items and select options.
• Drag. Hold the stylus on the screen and drag across the screen to select text and images. Drag

in a list to select multiple items.
• Tap-and-hold. Tap and hold the stylus on an item to see a list of actions available for that item.

On the pop-up menu that appears, tap the action you want to perform.

Today Screen
When you turn on your Pocket PC for the first time each day (or after 4 hours of inactivity),
you’ll see the Today screen. You can also display it by tapping  and then Today. On the Today
screen, you can see at a glance important information for the day.

Tap to change the date and time.

Tap to customize this screen.

Tap to open an item.

Your day at a glance

Status icons

Tap to switch to a program.

Tap to create a new item.
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You may see the following status icons on the command bar.

Programs
You can switch from one program to another by selecting it from the  menu. (You can
customize which programs you see on this menu. For information, see “Adjusting Settings,” later
in this chapter.) To access some programs, you’ll need to tap , Programs, and then the
program name.
You can also switch to some programs by pressing a program button. Your Pocket PC has one or
more program buttons located on its front or side. The icons on the buttons identify the programs
they switch to.

The following table contains a partial list of programs that are on your Pocket PC. Look in the
Extras folder on the ActiveSync CD for additional programs that you can install onto your Pocket
PC.

Status Icon Meaning

Turns all sounds on and off

Backup battery is low

Backup battery is very low

Main batteries are charging

Main batteries are very low

External (AC) power source is connected

Dial-up connection is active

Direct connection is active
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Navigation Bar and Command Bar
The navigation bar is located at the top of the screen. It displays the active program and current
time, and allows you to switch to programs and close screens.
Use the command bar at the bottom of the screen to perform tasks in programs. The command bar
includes menu names, buttons, and the input panel button. To create a new item in the current
program, tap New. To see the name of a button, tap and hold the stylus on the button. Drag the
stylus off the button so that the command is not carried out.

Tap to close the screen.

Tap to select a program.

Tap to see additional programs.
Tap to customize the device.

Starting up an application from the        menu 
causes its icon to appear here. Up to six 
applications can be displayed. You can make 
an application active by tapping its icon.

New button Input panel button

Menu names
Buttons

Program

Calendar

Contacts

Inbox

Notes

Pocket Excel

Pocket Word

Tasks

Description

Keep track of your appointments and create meeting requests.

Keep track of your friends and colleagues.

Send and receive e-mail messages.

Create handwritten or typed notes, drawings, and recordings.

Create new workbooks or view and edit Excel workbooks
created on your desktop computer.

Create new documents or view and edit Word documents
created on your desktop computer.

Keep track of your tasks.

Icon
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Pop-up Menus
With pop-up menus, you can quickly choose an action for an item. For example, you can use the
pop-up menu in the contact list to quickly delete a contact, make a copy of a contact, or send an e-
mail message to a contact. The actions in the pop-up menus vary from program to program. To
access a pop-up menu, tap and hold the stylus on the item name that you want to perform the
action on. When the menu appears, lift the stylus, and tap the action you want to perform. Or tap
anywhere outside the menu to close the menu without performing an action.

Tap and hold to display
the pop-up menu.

Lite the stylus and tap
the action you want.

Tap outside the menu to close it 
without performing an action.

Notifications
Your Pocket PC reminds you in a variety of ways when you have something to do. For example,
if you’ve set up an appointment in Calendar, a task with a due date in Tasks, or an alarm in Clock,
you’ll be notified in any of the following ways:
• A message box appears on the screen.
• A sound, which you can specify, is played.
• A light flashes on your Pocket PC.

To choose reminder types and sounds for your Pocket PC, tap   and then Settings. In the
Personal tab, tap Sounds & Reminders. The options you choose here apply throughout the
Pocket PC.

Enter Information on Your Pocket PC
You have several options for entering new information:
• Use the input panel to enter typed text, either by using the soft keyboard or Character

Recognizer.
• Write directly on the screen.
• Draw pictures on the screen.
• Speak into your Pocket PC microphone to record a message.
• Use ActiveSync to synchronize or copy information from your desktop computer to your

Pocket PC. For more information on ActiveSync, see the documentation accompanying the
ActiveSync CD or ActiveSync Help on your desktop computer.
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Typing Using the Input Panel
Use the input panel to enter information in any program on your Pocket PC. You can either type
using the soft keyboard or write using Character Recognizer. In either case, the characters appear
as typed text on the screen.
To show or hide the input panel, tap the Input Panel button. Tap the arrow next to the Input
Panel button to see your choices.

Tap to see your choices.

Select an input method.

Input Panel button

When you use the input panel, your Pocket PC anticipates the word you are typing or writing and
displays it above the input panel. When you tap the displayed word, it is inserted into your text at
the insertion point. The more you use your Pocket PC, the more words it learns to anticipate.

Tap here if this is the right word.

To change word suggestion options, such as the number of words suggested at one time,
tap , Settings, Personal tab, Input, and then the Word Completion tab.

To type with the soft keyboard
1. Tap the arrow next to the Input Panel button and then Keyboard.
2. On the soft keyboard that is displayed, tap the keys with your stylus.

To use Character Recognizer
1. Tap the arrow next to the Input Panel button and then Character Recognizer.
2. Write a letter in the box.

When you write a letter, it is converted to typed text that appears on the screen. For specific
instructions on using Character Recognizer, see Appendix A.
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To select typed text
If you want to edit or format typed text, you must select it first.
• Drag the stylus across the text you want to select.

You can cut, copy, and paste text by tapping and holding the selected words and then tapping an
editing command on the pop-up menu, or by tapping the command on the Edit menu.

Writing on the Screen
In any program that accepts writing, such as the Notes program and the Notes tab in Calendar,
Contacts, and Tasks, you can use your stylus to write directly on the screen. Write the way you do
on paper. You can edit and format what you’ve written and convert the information to text at a
later time.

To write on the screen
Tap the Pen button to switch to writing mode. This action displays lines on the screen to help you
write.

Tap the Pen button and use
your stylus like a pen.

Some programs that accept writing may not have the Pen button. See the documentation
for that program to find out how to switch to writing mode.

To select writing
If you want to edit or format writing, you must select it first.
1. Tap and hold the stylus next to the text you want to select until the insertion point appears.
2. Without lifting, drag the stylus across the text you want to select.

If you accidentally write on the screen, tap Edit and then Undo and try again. You can also select
text by tapping the Pen button to deselect it and then dragging the stylus across the screen.
You can cut, copy, and paste written text in the same way you work with typed text: tap and hold
the selected words and then tap an editing command on the pop-up menu, or tap the command on
the Edit menu.
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To convert writing to text
Tap Tools and then Recognize.
If you want to convert only certain words, select them before tapping Recognize on the Tools
menu (or tap and hold the selected words and then tap Recognize on the pop-up menu). If a word
is not recognized, it is left as writing.

Select the text you want
to convert and tap Recognize 
on the pop-up menu.

The writing is turned 
into text.

If the conversion is incorrect, you can select different words from a list of alternates or return to
the original writing. To do so, tap and hold the incorrect word (tap one word at a time). On the
pop-up menu, tap Alternates. A menu with a list of alternate words appears. Tap the word you
want to use, or tap the writing at the top of the menu to return to the original writing.

Or, tap the word you want to use.

Tap to return to your original writing.
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Tips for getting good recognition
• Write neatly.
• Write on the lines and draw descenders below the line. Write the cross of the “t” and

apostrophes below the top line so that they are not confused with the word above. Write periods
and commas above the line.

• For better recognition, try increasing the zoom level to 300% using the Tools menu.
• Write the letters of a word closely and leave big gaps between words so that the Pocket PC can

easily tell where words begin and end.
• Hyphenated words, foreign words that use special characters such as accents, and some

punctuation cannot be converted.
• If you add writing to a word to change it (such as changing a “3” to an “8”) after you attempt to

recognize the word, the writing you add will not be included if you attempt to recognize the
writing again.

Drawing on the Screen
You can draw on the screen in the same way that you write on the screen. The difference between
writing and drawing on the screen is how you select items and how they can be edited. For
example, selected drawings can be resized, while writing cannot.

To create a drawing
Cross three ruled lines on your first stroke. A drawing box appears. Subsequent strokes in or
touching the drawing box become part of the drawing. Drawings that do not cross three ruled
lines will be treated as writing.

The drawing box indicates
the boundaries of the drawing.

Pen button

You may want to change the zoom level so that you can more easily work on or view your
drawing. Tap Tools and then a zoom level.
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To select a drawing
If you want to edit or format a drawing, you must select it first.
• Tap and hold the stylus on the drawing until the selection handle appears. To select multiple

drawings, deselect the Pen button and then drÉ' to select the drawings you want.

You can cut, copy, and paste selected drawings by tapping and holding the selected drawing and
then tapping an editing command on the pop-up menu, or by tapping the command on the Edit
menu. To resize a drawing, make sure the Pen button is not selected and drag a selection handle.

Recording a Message
In any program where you can write or draw on the screen, you can also quickly capture thoughts,
reminders, and phone numbers by recording a message. In Calendar, Tasks, and Contacts, you can
include a recording in the Notes tab. In the Notes program, you can either create a stand-alone
recording or include a recording in a written note. If you want to include the recording in a note,
open the note first.

To create a recording
1. Hold your Pocket PC’s microphone near your mouth or other source of sound.
2. Press and hold the Record hardware button on your Pocket PC until you hear a beep.
3. While holding down the Record button, make your recording.
4. To stop recording, release the Record button. Two beeps will sound. The new recording

appears in the note list or as an embedded icon.

You can also make a recording by tapping the Record button on the Recording toolbar.

To play a recording, tap it in the list or tap its icon in the note.

Indicates an embedded recording.

Tap to begin recording.

Tap to show or hide the Recording toolbar.
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Find and Organize Information
The Find feature on your Pocket PC helps you quickly locate information.
• On the  menu, tap Find. Enter the text you want to find, select a data type, and then tap Go

to start the search.

To quickly find information that is taking up storage space on your Pocket PC, select
Larger than 64 KB in Type.

You can also use the File Explorer to find files on your Pocket PC and to organize these files into
folders. On the  menu, tap Programs, and then File Explorer.

Tap the folder name to open it.

Tap and hold to create
a new folder.

Select the sort order for the list.

Tap to change folders.

You can move files in File Explorer by tapping and holding the item you want to move
and then tapping Cut or Copy and Paste on the pop-up menu.

Customize Your Pocket PC
You can customize your Pocket PC by adjusting Pocket PC settings and installing additional
software.

Adjusting Settings
You can adjust Pocket PC settings to suit the way you work. To see available options, tap ,
Settings, then the Personal or System tab located at the bottom of the screen.
You might want to adjust the following:
• Clock, to change the time or to set alarms
• Menus, to customize what appears on the  menu and to enable a pop-up menu from the

New button
• Owner Information, to enter your contact information
• Password, to limit access to your Pocket PC
• Power, to maximize battery life
• Today, to customize the information that is displayed on the Today screen
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Adding or Removing Programs
Programs added to your Pocket PC at the factory are stored in ROM (read-only memory). You
cannot remove or modify this software, and you’ll never accidentally lose ROM contents.
Programs and data files added to your Pocket PC after factory installation are stored in RAM
(random access memory). You can install any program created for your Pocket PC, as long as
your Pocket PC has enough memory. The most popular place to find software for your Pocket PC
is on the World Wide Web.

To add programs
You’ll need to install the appropriate software for your Pocket PC on your desktop computer
before installing it on your Pocket PC.
1. Determine your Pocket PC and processor type so that you know which version of the software

to install. Tap  and then Settings. On the System tab, tap About. Tap the Version tab, and
make a note of the information in Processor.

2. Download the program to your desktop computer (or insert the CD or disk that contains the
program into your desktop computer). You may see a single *.exe file, a *.zip file, a Setup.exe
file, or several versions of files for different Pocket PC types and processors. Be sure to select
the program designed for the Pocket PC and your Pocket PC processor type.

3. Read any installation instructions, Read Me files, or documentation that comes with the
program. Many programs provide special installation instructions.

4. Connect your Pocket PC and desktop computer.
5. Double-click the *.exe file.
• If the file is an installer, the installation wizard will begin. Follow the directions on the screen.

Once the software has been installed on your desktop computer, the installer will automatically
transfer the software to your Pocket PC.

• If the file is not an installer, you will see an error message stating that the program is valid but
it is designed for a different type of computer. You will need to move this file to your Pocket
PC. If you cannot find any installation instructions for the program in the Read Me file or
documentation, use ActiveSync Explore to copy the program file to the Program Files folder on
your Pocket PC. For more information on copying files using ActiveSync, see ActiveSync
Help.

Once installation is complete, tap , Programs, and then the program icon to switch to it.
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To add a program to the Start menu
Tap , Settings, Menus, the Start Menu tab, and then the check box for the program. If you do
not see the program listed, you can either use File Explorer on the Pocket PC to move the
program to the Start Menu folder or use ActiveSync on the desktop computer to create a shortcut
to the program and place the shortcut in the Start Menu folder.

• Using File Explorer on the Pocket PC
Tap , Programs, File Explorer, and locate the program (tap the folder list, labeled My
Documents by default, and then My Device to see a list of all folders on the Pocket PC). Tap
and hold the program and tap Cut on the pop-up menu. Open the Start Menu folder located in
the Windows folder, tap and hold a blank area of the window, and tap Paste on the pop-up
menu. The program will now appear on the  menu. For more information on using File
Explorer, see “Find and Organize Information” earlier in this chapter.

• Using ActiveSync on the desktop computer
Use the Explorer in ActiveSync to explore your Pocket PC files and locate the program. Right-
click the program, and then click Create Shortcut. Move the shortcut to the Start Menu folder
in the Windows folder. The shortcut now appears on the  menu. For more information, see
ActiveSync Help.

To remove programs
• Tap  and then Settings. On the System tab, tap Remove Programs.
If the program does not appear in the list of installed programs, use File Explorer on your Pocket
PC to locate the program, tap and hold the program, and then tap Delete on the pop-up menu.
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Chapter 3: Microsoft ActiveSync
Using Microsoft ActiveSync, you can synchronize the information on your desktop computer with
the information on your Pocket PC. Synchronization compares the data on your Pocket PC with
your desktop computer and updates both computers with the most recent information. For
example:
• Keep Pocket Outlook data up-to-date by synchronizing your Pocket PC with your choice of

Microsoft Outlook, Microsoft Schedule+, or Microsoft Exchange on your desktop computer.
• Synchronize Microsoft Word and Microsoft Excel documents between your Pocket PC and

desktop computer. Your files are automatically converted to the correct format.

By default, ActiveSync does not automatically synchronize all types of information, for
example, e-mail messages. Use ActiveSync options to turn synchronization on and off for
specific information types.

With ActiveSync, you can also:
• Back up and restore your Pocket PC data.
• Copy (rather than synchronize) files between your Pocket PC and desktop computer.
• Control when synchronization occurs by selecting a synchronization mode. For example, you

can synchronize continually while the Pocket PC is connected to your desktop computer (using
a cradle or the cable), or only when you choose the synchronize command.

• Select which information types are synchronized and control how much data is synchronized.
For example, you can choose how many weeks of past appointments you want synchronized.

For information on installing ActiveSync, see the documentation accompanying the ActiveSync
CD. For information on using ActiveSync, see ActiveSync Help on the desktop computer.
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Chapter 4: Microsoft Pocket Outlook
Microsoft Pocket Outlook® includes Calendar, Contacts, Tasks, Inbox, and Notes. You can use
these programs individually or together. For example, e-mail addresses stored in Contacts can be
used to address e-mail messages in Inbox.
Using ActiveSync, you can synchronize information in Microsoft Outlook, Microsoft Schedule+,
or Microsoft Exchange on your desktop computer with your Pocket PC. Each time you
synchronize, ActiveSync compares the changes you made on your Pocket PC and desktop
computer and updates both computers with the latest information. For information on using
ActiveSync, see ActiveSync Help on the desktop computer.
You can switch to any of these programs by tapping them on the  menu.

Calendar: Scheduling Appointments and
Meetings

Use Calendar to schedule appointments, including meetings and other events. You can check your
appointments in one of several views (Agenda, Day, Week, Month, and Year) and easily switch
views by using the View menu.

Tap to go to today.

Tap to display or edit
the appointment details.

Tap to create a new appointment.

You can customize the Calendar display, such as changing the first day of the week, by
tapping Options on the Tools menu.

Week Numbering
• The week numbering system employed by the Calendar application does not conform

to ISO week calculation methods.
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To create an appointment
1. If you are in Day or Week view, tap the desired date and time for the appointment.
2. Tap New.

Tap to return to the calendar
(the appointment is saved automatically).

Tap to select a time.
Tap to select a date.

Notes is a good place
for maps and directions.

Tap to choose from
previously entered locations.

Tap to choose from
predefined text.

3. Using the input panel, enter a description and a location. Tap first to select the field.
4. If needed, tap the date and time to change them.
5. Enter other desired information. You will need to hide the input panel to see all available

fields.
6. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more

information on creating notes, see “Notes: Capturing Thoughts and Ideas” later in this chapter.
7. When finished, tap OK to return to the calendar.

If you select Remind me in an appointment, your Pocket PC will remind you according
to the options set in , Settings, Personal tab, Sounds & Reminders.
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Using the Summary Screen
When you tap an appointment in Calendar, a summary screen is displayed. Tap the top portion of
the summary screen to change the appointment.

Tap to edit the appointment details.

Tap to enter or edit notes.

Creating Meeting Requests
You can use Calendar to set up meetings with users of Outlook, Pocket Outlook, or Schedule+.
The meeting notice will be created automatically and sent either when you synchronize Inbox or
when you connect to your e-mail server. Indicate how you want meeting requests sent by tapping
Tools and then Options. If you send and receive e-mail messages through ActiveSync, select
ActiveSync.

To schedule a meeting
1. Create an appointment.
2. In the appointment details, hide the input panel, and then tap Attendees.
3. From the list of e-mail addresses you’ve entered in Contacts, select the meeting attendees.

The meeting notice is created automatically and placed in the Outbox folder.
For more information on sending and receiving meeting requests, see Calendar Help and Inbox
Help on the Pocket PC.
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Contacts: Tracking Friends and Colleagues
Contacts maintains a list of your friends and colleagues so that you can easily find the information
you’re looking for, whether you’re at home or on the road. Using the Pocket PC infrared (IR) port,
you can quickly share Contacts information with other Windows-powered Pocket PC users.

Select the category of contacts
you want displayed in the list.

Tap and enter part of a name to
quickly find it in the list.
Tap to see additional phone
numbers and e-mail addresses.

Tap to display or edit the contact details.

Tap and hold to display
a pop-up menu of actions.

Tap to create a new contact.

To change the way information is displayed in the list, tap Tools and then Options.

To create a contact
1. Tap New.

Tap to return to the contact list 
(the contact is saved automatically).

Notes is a good place 
for maps and directions.

Scroll to see more fields.

2. Using the input panel, enter a name and other contact information. You will need to scroll
down to see all available fields.
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3. To assign the contact to a category, scroll to and tap Categories and select a category from the
list. In the contact list, you can display contacts by category.

4. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more
information on creating notes, see “Notes: Capturing Thoughts and Ideas” later in this chapter.

5. When finished, tap OK to return to the contact list.

Using the Summary Screen
When you tap a contact in the contact list, a summary screen is displayed.

Tap to enter or edit notes.

Tap to edit the contact details.

Tasks: Keeping a To Do List
Use Tasks to keep track of what you have to do. In the task list, overdue tasks are displayed in
bold (and in red on color Pocket PCs).

Select the sort order 
of the list.
Indicates high priority.

Tap to display or edit
the task details.

Tap and hold to display
a pop-up menu of actions.

Select the category of tasks
you want displayed in the list.

Tap to create a new task.

To change the way information is displayed in the list, tap Tools and then Options.
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To create a task
1. Tap New.

Tap to choose from
predefined subjects.

Notes is a good place
for maps and drawings.

Tap to return to the task list 
(the task is saved automatically).

2. Using the input panel, enter a description.
3. You can enter a start date and due date or enter other information by first tapping the field. If

the input panel is open, you will need to hide it to see all available fields.
4. To assign the task to a category, tap Categories and select a category from the list. In the task

list, you can display tasks by category.
5. To add notes, tap the Notes tab. You can enter text, draw, or create a recording. For more

information on creating notes, see “Notes: Capturing Thoughts and Ideas” later in this chapter.
6. When finished, tap OK to return to the task list.

To quickly create a task with only a subject, tap Entry Bar on the Tools menu. Then, tap
Tap here to add a new task and enter your task information.

Using the Summary Screen
When you tap a task in the task list, a summary screen is displayed.

Tap to edit the task details.

Tap to show and hide additional
summary information.

Tap to enter or edit notes.
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Notes: Capturing Thoughts and Ideas
Quickly capture thoughts, reminders, ideas, drawings, and phone numbers with Notes. You can
create a written note or a recording. You can also include a recording in a note. If a note is open
when you create the recording, it will be included in the note as an icon. If the note list is
displayed, it will be created as a stand-alone recording.

Tap to change the sort
order of the list.

Tap to open a note or
play a recording.

Tap and hold to display
a pop-up menu of actions.

Tap to record.

Tap to show or hide the
Recording toolbar.

Tap to create a new item.

To create a note
1. Tap New.
2. Create your note by writing, drawing, typing, and recording. For more information about using

the input panel, writing and drawing on the screen, and creating recordings, see Chapter 2.

Tap to return to the note list 
(the note is saved automnatically).

Tap to write on the screen.

Tap to show or hide the input panel.

Tap to add a recording to the note.
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Inbox: Sending and Receiving E-mail
Messages

Use Inbox to send and receive e-mail messages in either of these ways:
• Synchronize e-mail messages with Microsoft Exchange or Microsoft Outlook on your desktop

computer.
• Send and receive e-mail messages by connecting directly to an e-mail server through an

Internet service provider (ISP) or a network.

Synchronizing E-mail Messages
E-mail messages can be synchronized as part of the general synchronization process. First, you’ll
need to enable Inbox synchronization in ActiveSync options. For information on enabling Inbox
synchronization, see ActiveSync Help on the desktop computer.

During synchronization:
• E-mail messages are copied from the Inbox folder of Exchange or Outlook on your desktop

computer to the Inbox folder on your Pocket PC. The e-mail messages on the two computers
are linked, so when you delete an e-mail message on your Pocket PC, it’s also deleted from
your desktop computer the next time you synchronize.

• E-mail messages in the Outbox folder on your Pocket PC are transferred to Exchange or
Outlook, and then sent from those programs.

You can also synchronize e-mail messages with your desktop computer from a remote
location. For more information, see Chapter 7.

Connecting Directly to an E-mail Server
In addition to synchronizing e-mail messages with your desktop computer, you can send and
receive e-mail messages by connecting to an e-mail server using a modem or network card
connected to your Pocket PC. You’ll need to set up a remote connection to a network or an ISP,
and a connection to your e-mail server. For more information, see Chapter 7.
When you connect to the e-mail server, new messages are downloaded to the Pocket PC Inbox
folder, messages in the Pocket PC Outbox folder are sent, and messages that have been deleted on
the e-mail server are removed from the Pocket PC Inbox.
Messages that you receive directly from an e-mail server are linked to your e-mail server rather
than your desktop computer. When you delete a message on your Pocket PC, it’s also deleted
from the e-mail server the next time you connect.
You can work online or offline. When working online, you read and respond to messages while
connected to the e-mail server. Messages are sent as soon as you tap Send, which saves space on
your Pocket PC.
When working offline, once you’ve downloaded new message headers or partial messages, you
can disconnect from the e-mail server and then decide which messages to download completely.
The next time you connect, Inbox downloads the complete messages you’ve marked for retrieval
and sends the messages you’ve composed.
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Using the Message List
Messages you receive are displayed in the message list. By default, the most recently received
messages are displayed first in the list.

Select the service and folder
you want to display.

Tap to connect and to send and receive e-mail.

Tap to connect to the selected service.

Select the sort order
from messages.

Tap and hold to display
a pop-up menu of actions.

Tap to open a message.

When you receive a message, tap it in the list to open it. Unread messages are displayed in bold.

Tap to view the previous or next message.

Tap to replay to or forward this message.

Tap to return to the message list.

Tap to delete this message.

Tap to show or hide the complete header.
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When you connect to your e-mail server or synchronize with your desktop computer, Inbox
downloads only the first 100 lines of each new message by default. No e-mail attachments are
downloaded. The original messages remain on the e-mail server or your desktop computer.
You can mark the messages that you want to retrieve in their entirety the next time you
synchronize or connect to your e-mail server. In the message list, tap and hold the message you
want to retrieve. On the pop-up menu, tap Get Full Copy. The icons in the Inbox message list
give you visual indications of message status.
You’ll need to download a full message before you can view its attachments. Attachments appear
as icons in a window pane at the bottom of the message. Tapping an attachment icon opens the
attachment if it has been fully downloaded or marks it for download the next time you
synchronize or connect to your e-mail server.
You specify your downloading preferences when you set up the service or select your
synchronization options. You can change them at any time.
• Change options for Inbox synchronization using ActiveSync options. For more information, see

ActiveSync Help.
• Change options for direct e-mail server connections in Inbox on your Pocket PC. Tap Tools and

then tap Options. On the Service tab, tap the service you want to change.

Composing E-mail Messages

To compose an e-mail message
1. Tap New.
2. Enter an e-mail address in To, or select a name from the contact list by tapping the Address

Book button.

All e-mail addresses entered in the e-mail fields in Contacts appear in the Address Book.

Tap to check names in the To, Cc,
and Bcc boxes with names in Contacts
and/or an online address book.

Tap to attach a file.

Tap to display the Address Book.

Tap to show or hide
the complete header.

Tap to send the message.
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3. Compose your message.
4. Tap Send when you’ve finished the message.
The message is placed in the Outbox folder on your Pocket PC and will be delivered in one of two
ways.
• They are transferred to the Outbox folder in Exchange or Outlook on your desktop computer

and sent the next time you synchronize.
• They are transferred to your e-mail server the next time you connect. In Inbox, make sure the

appropriate service is selected on the Services menu. Then tap the Connect button (or Connect
on the Services menu).

Managing E-mail Messages and Folders
By default, messages are displayed in one of four folders for each service you’ve created: Inbox,
Deleted (local), Outbox, and Sent. The Deleted folder contains messages that have been deleted
on the Pocket PC. If you are using IMAP4, you may see a Deleted Items folder. This folder is for
messages deleted on the e-mail server. The behavior of the Deleted and Sent folders depends on
the options you have chosen. In the message list, tap Tools and then Options. On the Message
tab, select your options.
If you want to organize messages into additional folders, tap Tools, and then New Folder to
create new folders. To move or copy a message to another folder, in the message list, tap and hold
the message and then tap Move to or Copy to on the pop-up menu.

Folder behavior with ActiveSync
If you move e-mail messages into a folder you create, the link is broken between these e-mail
messages and their copies on the desktop computer. When you synchronize next, the e-mail
messages in the folder you created will not be synchronized. In addition, e-mail messages that are
missing from the Pocket PC Inbox folder will be deleted from the Inbox folder on the desktop
computer so that both Inbox folders match. This prevents you from getting duplicate copies of an
e-mail message, but it also means that you will no longer have access to the e-mail messages you
move out of Inbox except from the Pocket PC.

Folder behavior with a direct connection to an e-mail server
The behavior of the folders you create depends on whether you are using POP3 or IMAP4.
If you are using POP3, folders will behave like they do when using ActiveSync.
If you are using IMAP4, the folders you create and the messages you move are mirrored on the e-
mail server. For example, if you move two messages from the Inbox folder to a folder called
Family, the e-mail server will create a copy of the Family folder and move the messages into that
folder. Therefore, messages are available to you anytime you connect to your e-mail server,
whether it is from your Pocket PC, laptop computer, or desktop computer. This synchronization of
folders occurs when you create a new folder, move e-mail messages into a folder, or tap
Synchronize Folders on the Services menu. If you want to view the messages in a folder while
disconnected from your e-mail server, select the folder and then tap Folder Available Offline on
the Services menu. This downloads the e-mail message in the folder to your Pocket PC.
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Chapter 5: Companion Programs
The companion programs consist of Microsoft Pocket Word, Microsoft Pocket Excel, Microsoft
Money, Windows Media Player for Pocket PC, Microsoft Reader, and Microsoft Pocket Streets.
To switch to a companion program on your Pocket PC, tap Programs on the  menu, and then
tap the program name.

Pocket Word
Pocket Word works with Microsoft Word on your desktop computer to give you easy access to
copies of your documents. You can create new documents on your Pocket PC, or you can copy
documents from your desktop computer to your Pocket PC. Synchronize documents between your
desktop computer and your Pocket PC so that you have the most up-to-date content in both
locations.
Use Pocket Word to create documents, such as letters, meeting minutes, and trip reports. To create
a new file, tap , Programs, Pocket Word, and then New. A blank document appears. Or, if
you’ve selected a template for new documents in the Options dialog box, that template appears
with appropriate text and formatting already provided. You can open only one document at a time;
when you open a second document, you’ll be asked to save the first. You can save a document
you create or edit in a variety of formats, including Pocket Word (.psw), Rich Text Format (.rtf),
and Plain Text (.txt).
Pocket Word contains a list of the files stored on your Pocket PC. Tap a file in the list to open it.
To delete, make copies of, and send files, tap and hold a file in the list. Then, select the
appropriate action on the pop-up menu.

Tap to create a new document.

Tap to change the sort
order of the list.

Tap to open a document.

Tap and hold an item to see
a pop-up menu of actions.

Select the type of folder you
want displayed in the list.



33

You can enter information in Pocket Word in one of four modes (writing, drawing, typing, and
recording), which are displayed on the View menu. Each mode has its own toolbar, which you can
show and hide by tapping the Show/Hide Toolbar button on the command bar.

You can change the zoom magnification by tapping View and then Zoom. Then select the
percentage you want. Select a higher percentage to enter text and a lower one to see more
of your document.
If you’re opening a Word document created on a desktop computer, select Wrap to
Window on the View menu so that you can see the entire document.

Typing Mode
Using the input panel, enter typed text into the document. For more information on entering typed
text, see Chapter 2.
To format existing text and to edit text, first select the text. You can select text as you do in a
Word document, using your stylus instead of the mouse to drag through the text you want to
select. You can search a document to find the text you want by tapping Edit and then Find/
Replace.

Tap to show or hide the toolbar.

Tap and hold to see a
pop-up menu of actions.

Tap to change formatting options.

Tap to form at text.

Tap to return to the document
list (changes are saved
automatically).
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Writing Mode
In writing mode, use your stylus to write directly on the screen. Ruled lines are displayed as a
guide, and the zoom magnification is greater than in typing mode to allow you to write more
easily. For more information on writing and selecting writing, see Chapter 2.

Tap to select formatting options,
such as pen weight and line color.

Space button
Pen button

With Space button selected, drag to 
insert space. An arrow appears 
showing the space direction and size.

Tap to highlight selected text.

If you cross three ruled lines in a single stylus stroke, the writing becomes a drawing, and
can be edited and manipulated as described in the following section.
Written words are converted to graphics (metafiles) when a Pocket Word document is
converted to a Word document on your desktop computer.
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Drawing Mode
In drawing mode, use your stylus to draw on the screen. Gridlines appear as guides. When you lift
your stylus off the screen after the first stroke, you’ll see a drawing box indicating the boundaries
of the drawing. Every subsequent stroke within or touching the drawing box becomes part of the
drawing. For more information on drawing and selecting drawings, see Chapter 2.

Tap to select formatting options,
such as line weight, fill color, and line color.

Tap an arrow to see your choices.
Pen button

Resize an object by dragging
the selection handles.

Select Shape on the pop-up menu 
to convert objects to proper shapes.

Recording Mode
In recording mode, embed a recording into your document. Recordings are saved as .wav files.
For more information on recording, see Chapter 2.
For more information on using Pocket Word, tap  and then Help.
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Pocket Excel
Pocket Excel works with Microsoft Excel on your desktop computer to give you easy access to
copies of your workbooks. You can create new workbooks on your Pocket PC, or you can copy
workbooks from your desktop computer to your Pocket PC. Synchronize workbooks between
your desktop computer and your Pocket PC so that you have the most up-to-date content in both
locations.
Use Pocket Excel to create workbooks, such as expense reports and mileage logs. To create a new
file, tap , Programs, Pocket Excel, and then New. A blank workbook appears. Or, if you’ve
selected a template for new workbooks in the Options dialog box, that template appears with
appropriate text and formatting already provided. You can open only one workbook at a time;
when you open a second workbook, you’ll be asked to save the first. You can save a workbook
you create or edit in a variety of formats, including Pocket Excel (.pxl) and Excel (.xls).
Pocket Excel contains a list of the files stored on your Pocket PC. Tap a file in the list to open it.
To delete, make copies of, and send files, tap and hold a file in the list. Then select the appropriate
action from the pop-up menu.
Pocket Excel provides fundamental spreadsheet tools, such as formulas, functions, sorting, and
filtering. To display the toolbar, tap View and then Toolbar.

Cell contents appear here
as you enter them.

Zoom button

Format button

AutoSum button

If your workbook contains sensitive information, you can protect it with a password. To
do so, open the workbook, tap Edit, and then Password. Every time you open the
workbook, you will need to enter the password, so choose one that is easy for you to
remember but hard for others to guess.
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Tips for Working in Pocket Excel
Note the following when working in large worksheets in Pocket Excel.
• View in full-screen mode to see as much of your worksheet as possible. Tap View and then Full

Screen. To exit full-screen mode, tap Restore.
• Show and hide window elements. Tap View and then tap the elements you want to show or

hide.
• Freeze panes on a worksheet. First select the cell where you want to freeze panes. Tap View

and then Freeze Panes. You might want to freeze the top and leftmost panes in a worksheet to
keep row and column labels visible as you scroll through a sheet.

• Split panes to view different areas of a large worksheet. Tap View and then Split. Then drag the
split bar to where you want it. To remove the split, tap View and then Remove Split.

• Show and hide rows and columns. To hide a hidden row or column, select a cell in the row or
column you want to hide. Then tap Format, then Row or Column, then Hide. To show a
hidden row or column, tap Tools, then Go To, and then type a reference that is in the hidden
row or column. Then tap Format, then Row or Column, and then Unhide.

For more information on using Pocket Excel, tap  and then Help.

Microsoft Money
Use Microsoft Money to easily enter and view your financial transactions, check your account
balances, and track your investments. If you are using Microsoft Money on your desktop computer,
you should synchronize first so that you won’t have to enter your accounts and other required
information on your Pocket PC by hand. Before you can synchronize, you will need to run the Setup
program found in the MSMoney folder under Extras on the ActiveSync CD. The first time you
synchronize, all Microsoft Money information on the Pocket PC will be replaced with information
from your desktop computer. If you do not use Microsoft Money on your desktop computer,
Microsoft Money on the Pocket PC can still be used to help organize your finances, but you will not
be able to synchronize the financial information with your desktop computer.
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Creating Accounts
To create a new account, tap , Programs, Microsoft Money, and then New. A screen for
entering account details with a Required and an Optional tab appears. Enter the name and type
of the account on the Required tab and the other information you want to record on the Optional
tab and then tap OK. The name of the account appears in the Account Manager with its opening
balance. The total of all balances for your accounts appears at the bottom of the screen.
Microsoft Money shows that you are in the Account Manager in the upper-left corner of the
screen. To navigate within Microsoft Money, tap the name Account Manager. A list of the five
screens within Microsoft Money appears. Tap the screen you want to see.

Tap to create a new account.

Balance for all accounts

Ending balance for each account

Tap to view the Account Register.

Tap and hold to see a
pop-up menu of actions.

Select the screen you want displayed.
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Using the Account Register
To view the Account Register for an account, tap it in the Account Manager. The Account
Register displays all transactions for that account that are stored on your Pocket PC. For each
transaction, you will see the date, the payee, the amount, and the running balance of your account
as a result of the transaction. The ending account balance is displayed at the bottom of the screen.

Tap to create a newtransaction.

Ending balance for account

Tap to view details.

Tap and hold to see a
pop-up menu of actions.

Transaction payee

Select the account you want displayed.
Transaction amount.

Running balance for account

To switch between accounts, tap the name of the current account in the upper-right corner
and select another account from the list.
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Entering Transactions
Once you have the Account Register open, tap New to create a new transaction.
On the Required tab, Microsoft Money automatically creates a withdrawal and enters today’s
date. If you are not entering a withdrawal, tap the Type box and select Deposit or Transfer. You
can also change the account in which the transaction is being created. Then, tap the Payee box.
Using the input panel, enter the payee for your transaction. As you type, Microsoft Money tries to
guess the payee that you are entering from your list of existing payees. If Microsoft Money
guesses correctly, tap another field or tap Tab to accept the payee.
When you accept a payee, Microsoft Money enters the same amount, category, and subcategory
that you used for the last transaction with that same payee. This information gets entered on the
Required tab and the Optional tab. This AutoComplete+ feature helps you quickly enter similar
transactions, such as ATM withdrawals. If AutoComplete+ has entered the wrong information, use
the input panel to correct it.

Tap to create a split transaction.

Tap to return to the Account Register
(the transaction is saved automatically).

Tap to select the transaction type.

Tap to select another account.

Tap to enter the payee.

Tap to enter the date.

Tap to enter the amount.
Tap to enter additional information
about the transaction.

If you do not want Microsoft Money to automatically enter information, tap Tools and
then Options and turn off AutoComplete+.
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Entering and Tracking Investments
In the Investments screen, you can track the value of the investments in your portfolio. The
Investments screen displays each investment with the current number of shares, their price, and
market value. The total market value for all of your investments is displayed at the bottom of the
screen.
To create a new investment, tap New. On the new investment screen, enter the name, symbol,
current price, and number of shares. Tap OK to save the new investment.
Microsoft Money can update investment prices from the MoneyCentral Web site. To do this, open
a connection to the Internet and tap Update Investments on the Tools menu. When the update is
complete, Microsoft Money will record the date and time and display it after Last Quote Update
at the bottom of the screen. If you do not have an Internet connection from your Pocket PC, you
can manually update the investment prices by tapping the investment and entering a new price
with the input panel.

Tap to view details.

Tap and hold to see a 
pop-up menu of actions.

Number of shares
Market symbol for investment

Latest market price

Market value of investment

Total market value of all investments
Time at which quotes were last 
updated, if available

Tap to update investment prices from MoneyCentral Web site.
Tap to create newinvestment.

Microsoft Money can get a quote update over any direct (IP) Internet connection,
including a wireless connection or network connection. If you cannot get a quote update,
check with your Internet service provider (ISP) or network administrator to see if you
require a proxy server to connect to the Internet. If so, tap Tools and then Options and set
up the proxy server.

For more information on using Microsoft Money, tap  and then Help.
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Windows Media Player for Pocket PC
Use Windows Media Player for Pocket PC to listen to digital audio files.
To switch to Windows Media Player, tap  and then Windows Media Player.

Active playlist

Indicates the ptogress of the current track

Skip back

Track information

Skip forward

Play/Pause

Repeat playlist

Stop

Shuffle playlist
Volume

Using Windows Media Manager for Pocket PC
Use Windows Media Manager for Pocket PC on the desktop computer to create digital audio files
in Windows Media format and to transfer audio content to your Pocket PC or storage card. With
Windows Media format, you can create high-quality audio for your Pocket PC without using large
amounts of Pocket PC memory.
You can transfer the following media formats to your Pocket PC for use with the Windows Media
Player: ASF (Advanced Streaming Format), WMA (Windows Media Audio), MP3 (MPEG Audio
Layer 3), and WAV (waveform).
Windows Media Manager is included in the Extras folder on the ActiveSync CD. You must install
Windows Media Manager on your desktop computer to copy and convert digital audio files.
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Click to download
the file.

Click to hide the
download status.

What is Packaged Content?
Packaged content is digital music that has been encrypted for distribution to prevent unauthorized
access to copyrighted content. Windows Media Player for Pocket PC cannot play packaged
content without a valid license. First use Windows Media Player on the desktop computer to
obtain packaged content that has a license that allows transferring the content to your Pocket PC.
Then use Windows Media Manager for Pocket PC to transfer the packaged content and its license
to your Pocket PC or storage card. To successfully transfer packaged content, your Pocket PC or
storage card may require a hardware serial number.
You can play packaged content until the license expires. During license download, you will be
informed of the terms of the license. License terms can be for an unlimited time, a set amount of
time, or a set number of playbacks. A license can support content being copied to a Pocket PC or
storage card an unlimited number of times or one time only. Terms are entirely dependent on the
content provider.
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Using the Playlist Manager
Use the playlist manager to set the track playback order. All My Music is the default playlist. It
contains all digital audio files available for playback on your Pocket PC and storage card. To see a
list of recently selected playlists, tap Select Playlist. To create or edit playlists, tap All Playlists.

Default playlist of all tracks

Previously selected playlists

Playlist management

Tap and hold a track or playlist to perform actions such as copying, moving, and deleting.
For more information on using Windows Media Player, tap  and then Help.

Microsoft Reader
Use Microsoft Reader to read electronic books on your Pocket PC.
Download books to your desktop computer from your favorite eBook Web site. Then, use
ActiveSync to copy the book files to your Pocket PC. The books appear in the Reader Library,
where you can tap them in the list to open them.
Each book consists of a cover page, an optional table of contents, and the pages of the book. Page
through the book by using the Up/Down control on your Pocket PC or by tapping the page
number on each page. You can annotate the book with highlighting, bookmarks, notes, and
drawings. You can also search for text and look up definitions for words.
The Reader Guidebook contains all the information you’ll need to use the software. To open the
Guidebook, tap Guidebook on the Reader command bar. Or, on a book page, tap the book title
and then tap Guidebook on the pop-up menu.
To switch to Microsoft Reader, tap , Programs, and then Microsoft Reader.

Getting Books on Your Pocket PC
You can download book files from the Web. Just visit your favorite eBook retailer and follow the
instructions to download the book files. Sample books and a dictionary are also included in the
MSReader folder in the Extras folder on the ActiveSync CD. Use ActiveSync to download the
files from your desktop computer to your Pocket PC as described in the Read Me file in the
MSReader folder.
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Using the Library
The Library is your home page; it displays a list of all books stored on your Pocket PC or storage
card.
You can go to the Library by tapping Library on the Reader command bar. Or on a book page,
tap the book title and then tap Library on the pop-up menu.
To open a book, tap its title in the Library list.

Tap to scroll through the Libarary list.

Tap to specify the books you 
want to display in the list.

Tap to open a book.

Tap an icon to nevigate
to other parts of the Reader.

Tap to select a sort order.

Reading a Book
Each book consists of a cover page, an optional table of contents, and the pages of the book.
Navigation options are listed in the bottom portion of the cover page. The first time you open a
book, you’ll probably want to go to the first page or to the table of contents, if there is one.
Subsequently, whenever you open the book, you’ll be automatically taken to the last page read.
In addition to the text, each book page includes a page number and book title.

Tap to turn the page.

Drag to select text and then tap an option.

Tap to select a navigation option.

You can also page through a book by using the Up/Down control on your Pocket PC.
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Using Reader Features
Reading a book electronically gives you several options not available with paper books. These
options are available from any book page.
Select text by dragging across the text on the page. Then, tap an option on the pop-up menu, as
described below.
• Search for Text. Find text in a book by tapping Find on the pop-up menu. Change the text that

appears in the Find box, if necessary, and tap the desired Find option. The Reader finds the text
and highlights it on the page. Tap outside the Find box to close it. To return to your original
page, tap the title and then tap Return on the pop-up menu.

• Copy Text. You can copy text from a book into any program that accepts text. On a book page,
select the text you want to copy. Then, tap Copy Text on the pop-up menu. The text you’ve
copied can be pasted into the program of your choice.

• Bookmarks. When you add a bookmark to a book, a color-coded bookmark icon appears in the
right margin. You can add multiple bookmarks to a book. Then, from anywhere in the book,
you can tap the bookmark icon to go to the bookmarked page.

• Highlights. When you highlight text, it appears with a colored background, just as if you used
a marker pen.

• Notes. When you attach a note to text, you enter the text in a note pad that appears on top of the
book page. A note icon appears in the left margin. You can show or hide the note by tapping the
icon.

• Drawings. When you add a drawing, a drawing icon appears in the bottom-left corner of the
page, and drawing tools appear across the bottom of the page. Draw by dragging your stylus.

To see a list of a book’s annotations, including bookmarks, highlights, text notes, and
drawings, tap Annotations Index on the book’s cover page. You can tap an entry in the
list to go to the annotated page.

Removing a Book
When you’ve finished reading a book, you may want to delete it to conserve space on your Pocket
PC. If a copy of the book is stored on your desktop computer, you can download it again at any
time. To remove a book from your Pocket PC, tap and hold the title in the Library list and then tap
Delete on the pop-up menu.

Pocket Streets
The Pocket Streets feature, included in Microsoft Expedia® Streets and Trips 2000, AutoRoute
Express™ Great Britain 2000, and Microsoft MapPoint™ 2000, delivers thousands of miles of
street map information to your Pocket PC. You can create custom maps of unfamiliar cities,
towns, and villages.

Installing Pocket Streets
Pocket Streets is included in the Extras folder on the ActiveSync CD. To install Pocket Streets on
your Pocket PC, go to the PStreets folder in the Extras folder on the ActiveSync CD and follow
the instructions in the Read Me file.

Getting Maps on Your Pocket PC
Sample maps are included in the PStreets folder in the Extras folder on the ActiveSync CD. Use
ActiveSync Explore to copy the files from your desktop computer to your Pocket PC. For more
information on copying files using ActiveSync, see ActiveSync Help.
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Creating Map and Pushpin Files for Your Pocket PC
1. In Microsoft Expedia Streets and Trips 2000, AutoRoute Express Great Britain 2000, or

Microsoft MapPoint 2000, draw a box around the area you want to save as a map.
2. On the Tools menu, click Create Map For Pocket Streets.
3. Click Create.
4. Navigate to the folder where you want to save the map, and then type a file name for the map.
5. Click Save. When you create a map, all visible Pushpins in the portion of the map that you

selected are also exported.
6. A map file and a corresponding Pushpin file are created for your Pocket PC.
7. Using ActiveSync, copy the maps (.mps) and/or Pushpin files (.psp) that you’ve created for

use with Pocket Streets to the My Documents folder on your Pocket PC. For more information
on using ActiveSync to copy files, see ActiveSync Help on the desktop computer.

Viewing Maps
To open a map, Tap Tools, Maps, and then the name of the map you want to see. If you don’t see
the name, tap Tools, Maps, and then Open Map, select the folder where you stored the map, and
then tap the name in the list.

Tap to mark the map with a Pushpin.

Tap to move the map view.
Tap to zoom in and out.

For more information on using Pocket Streets, tap  and then Help.
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Chapter 6: Pocket Internet Explorer
Use Pocket Internet Explorer to view Web pages in either of the following two ways.
• During synchronization with your desktop computer, download your favorite links, mobile

favorites, and mobile channels that are stored in the Mobile Favorites subfolder in Internet
Explorer on the desktop computer.

• Connect to an Internet service provider (ISP) or network and browse the Web. To do this, you’ll
need to create the connection first, as described in Chapter 7.

To switch to Pocket Internet Explorer, tap  and then Internet Explorer.

The Mobile Favorites Folder
Only items stored in the Mobile Favorites subfolder in the Favorites folder in Internet Explorer on
your desktop computer will be synchronized with your Pocket PC. This folder was created
automatically when you installed ActiveSync.

Favorite Links
During synchronization, the list of favorite links in the Mobile Favorites folder on your desktop
computer is synchronized with Pocket Internet Explorer on your Pocket PC. Both computers are
updated with changes made to either list each time you synchronize. Unless you mark the favorite
link as a mobile favorite, only the link will be downloaded to your Pocket PC, and you will need
to connect to your ISP or network to view the content. For more information on synchronization,
see ActiveSync Help on the desktop computer.

Mobile Favorites
If you are using Microsoft Internet Explorer 5 on your desktop computer, you can download
mobile favorites. (You can install Microsoft Internet Explorer 5 from the Extras folder on the
ActiveSync CD.) Synchronizing mobile favorites downloads Web content to your Pocket PC so
that you can view Web pages while you are disconnected from your ISP and desktop computer.
Use the Internet Explorer 5 plug-in installed with ActiveSync to create mobile favorites quickly.

To create a mobile favorite
1. In Internet Explorer 5 on your desktop computer, click Tools and then Create Mobile

Favorite.
2. To change the link name, enter a new name in the Name box.
3. Optionally, in Update, select a desired update schedule.
4. Click OK. Internet Explorer downloads the latest version of the Web page to your desktop

computer.
5. If you want to download the pages that are linked to the mobile favorite you just created, in

Internet Explorer on the desktop computer, right-click the mobile favorite and then click
Properties. On the Download tab, specify the number of links deep you want to download. To
conserve Pocket PC memory, only go 1 level deep.

6. Synchronize your Pocket PC and desktop computer. Mobile favorites that are stored in the
Mobile Favorites folder in Internet Explorer 5 are downloaded to your Pocket PC.
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If you did not specify an update schedule in step 3, you will need to manually download
content to keep the information updated on your desktop computer and Pocket PC.
Before synchronizing with your Pocket PC, in Internet Explorer on your desktop
computer, click Tools and then Synchronize. You will see the last time content that was
downloaded to the desktop computer, and you can manually download content if needed.
You can add a button to the Internet Explorer toolbar for creating mobile favorites. In
Internet Explorer 5 on your desktop computer, click View, Toolbars, and then
Customize.

To save Pocket PC memory
Mobile favorites take up storage memory on your Pocket PC. Use the following techniques to
minimize the amount of memory used.
• In the settings for the Favorites information type in ActiveSync options, turn off pictures and

sounds or stop some mobile favorites from being downloaded to the Pocket PC. For more
information, see ActiveSync Help.

• Limit the number of downloaded linked pages. In Internet Explorer on the desktop computer,
right-click the mobile favorite you want to change and then Properties. On the Download tab,
specify 0 or 1 for the number of linked pages you want to download.

Channels
Channels are Web sites designed specifically for offline viewing on your Pocket PC. You can
subscribe to two types of channels at no fee: AvantGo Channels and mobile channels.

Using AvantGo Channels
AvantGo is a free interactive service that gives you access to personalized content and thousands
of popular Web sites. Unlike mobile channels, you can subscribe to AvantGo channels directly
from your Pocket PC. Then, you synchronize your Pocket PC and desktop computer or connect to
the Internet to download the content. For more information, visit http://avantgo.com/help.

To sign up for AvantGo
1. In ActiveSync options on the desktop computer, turn on synchronization for the AvantGo

information type.
2. In Pocket Internet Explorer on your Pocket PC, tap the Favorites button to display your list of

favorites.
3. Tap the AvantGo Channels link.
4. Tap the Activate button.
5. Follow the directions on the screen. You will need to synchronize your Pocket PC with your

desktop computer and then tap the My Channels button to complete the AvantGo setup.

When synchronization is complete, tap the AvantGo Channels link in your list of favorites to see a
few of the most popular channels. To add or remove channels, tap the Add or Remove link.
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Using Mobile Channels
Mobile channels are sites you subscribe to on your desktop computer. They are stored in the
Channels subfolder in the Mobile Favorites folder in Internet Explorer 4.0 or later and are
downloaded to your Pocket PC during synchronization.
To see a list of mobile channels you can subscribe to at no fee, visit the Windows CE Mobile
Channel List Web page (http://www.microsoft.com/windowsce/channels). Click the Add Mobile
Channel button and select Make available offline to download the channel to your desktop
computer. The mobile channel will be transferred to your Pocket PC the next time you synchronize.
For more information on synchronization, see ActiveSync Help on the desktop computer.

Use Pocket Internet Explorer
You can use Pocket Internet Explorer to browse mobile favorites and channels that have been
downloaded to your Pocket PC without connecting to the Internet. You can also connect to the
Internet through an ISP or a network connection and browse the Web.

Favorites button
Home button

Refresh button
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To view mobile favorites and channels
1. Tap the Favorites button to display your list of favorites.

Tap the favorite you want to view.

Tap to add or delete a favorite link.

2. Tap the mobile favorite or channel you want to view.

You’ll see the page that was downloaded the last time you synchronized with your desktop
computer. If the page is not on your Pocket PC, the favorite will be dimmed. You will need to
synchronize with your desktop computer again to download the page to your Pocket PC or
connect to the Internet to view the page.

To browse the Web
1. Connect to the Internet or your network in either of the following ways.
• Connect using Connections, as described in Chapter 7. Then switch to Pocket Internet

Explorer by tapping it on the  menu.
• Connect in Pocket Internet Explorer. To select a service or type of connection, tap Tools and

then Options. Tap the Connections tab and select the connection type. Then, whenever you
want to connect to the selected service, tap Tools and then Connect.

You can have Pocket Internet Explorer automatically connect to the Internet when you
attempt to access a page that is not stored on your Pocket PC by specifying a connection
in the Connection tab in Options and selecting Access remote content automatically.

2. Once connected, go to a specific Web page in either of these ways.
• Tap the Favorites button and then tap the favorite you want to view.
• Tap View and then Address Bar. In the address bar that appears at the top of the screen, enter

the Web address you want to visit and then tap Go. Tap the arrow to choose from previously
entered addresses.

3. To end the connection, tap Tools and then Disconnect.

To add a favorite link while using the Pocket PC, go to the Web page you want to add, tap
the Favorites button, tap the Add/Delete tab, tap the Add button, and enter a name for
the favorite link.



52

Chapter 7: Getting Connected
You can use your Pocket PC to exchange information with other Windows-powered Pocket PCs
as well as your desktop computer, a network, or the Internet. Use the infrared (IR) port on your
Pocket PC to send and receive files between two Pocket PCs. In addition to using a cradle, cable,
or IR port to connect your Pocket PC to your desktop computer (as described in Chapter 3), you
can connect to your desktop computer while away from the office by using a remote connection.
You can also connect your Pocket PC to a network or the Internet by using a remote connection.
You have the following connection options.
• Connect to your Internet service provider (ISP). Once connected, you can send and receive e-

mail messages by using Inbox and view Web pages by using Pocket Internet Explorer. If this is
the method you want to use, see “Connect to an ISP.” The communication software for creating
an ISP connection is already installed on your Pocket PC. Your service provider will provide
software needed to install other services, such as paging and fax services.

• Connect to the network at your company or organization. Once connected, you can send and
receive e-mail messages by using Inbox, view Web pages by using Pocket Internet Explorer,
and synchronize with your desktop computer. If this is the method you want to use, see
“Connect to Your Network.”

• Connect to your desktop computer to synchronize remotely. Once connected, you can
synchronize information such as your Pocket Outlook data. If this is the method you want to
use, see ActiveSync Help on your desktop computer or Connections Help on the Pocket PC.

Transfer Items Using Infrared
Using infrared (IR), you can send and receive information, such as contacts and appointments,
between two Windows-powered Pocket PCs.

To send information
1. Switch to the program where you created the item you want to send and locate the item in the

list. If you want to send more than one item, drag the stylus across the items you want to send.
2. Align the IR ports so that they are unobstructed and within a close range.

• The two infrared ports should be within about 20cm from each other.
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3. Tap and hold the item, and tap Send via Infrared on the pop-up menu.

You can also send items, but not folders, from File Explorer. Tap and hold the item you
want to send, and then tap Send via Infrared on the pop-up menu.

To receive information
1. Align the IR ports so that they are unobstructed and within a close range.
2. Tap , Programs, and then Infrared Receive.

You can also receive items from Tasks, Contacts, Calendar, and Notes by tapping Tools
and then Receive via Infrared in list view.

Connect to an ISP
You can connect to your ISP by creating a modem connection. Once connected, you can send and
receive e-mail messages and view Web pages.

To create a modem connection to an ISP
1. Get the following information from your ISP: ISP dial-up access telephone number, user

name, password, and TCP/IP settings. Some ISPs require information in front of the user
name, such as MSN/username.

2. If your Pocket PC does not have a built-in modem, install a modem card or use a NULL
modem cable and appropriate adapters to connect an external modem to your Pocket PC
through the serial port.

3. Tap  and then Settings. On the Connections tab, tap Modem.
4. Tap New connection.

5. Enter a name for the connection, such as “ISP Connection.”
6. In the Select a modem list, select your modem type. If your modem type does not appear, try

re-inserting the modem card. If you are using an external modem that is connected to your
Pocket PC with a cable, select Hayes Compatible on COM1.

7. You should not need to change any settings in Advanced. Most ISPs now use a server-
assigned address. If the ISP you are connecting to does not use a server-assigned address, tap
Advanced and then the TCP/IP tab and enter the address. When finished, tap OK and then
Next.

8. Enter the access phone number, and tap Next.
9. Select other desired options, and tap Finish.



54

10.On the Dialing tab, specify your current location and phone type (most phone lines are tone).
These settings will apply to all connections you create.

Once you have created the connection, it appears in , Programs, Connections. To start the
connection, remove your Pocket PC from the cradle or disconnect the cable, tap the connection
icon, enter your user name and password, and tap Connect. Once connected, you can:
• Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need to

provide the information it needs to communicate with the e-mail server. For specific
instructions, see “Connect Directly to an E-mail Server,” later in this chapter.

• Visit Web pages by using Pocket Internet Explorer. For more information, see Chapter 6.

You can quickly return to Modem Settings to change connection settings by tapping the
Modem link at the bottom of the Connections folder. To return to the Connections folder,
tap the Connections link.

Connect to Your Network
If you have access to a network, you can send e-mail messages, view intranet pages, synchronize
your Pocket PC, and possibly access the Internet. You can connect to your network in one of two
ways.
• Create a modem connection by using a RAS account. Before you can create this modem

connection, your network administrator will need to set up a RAS account for you. If this is the
method you want to use, see “To create a modem connection to a network.”

• Use an Ethernet card and a net tap to connect to the network. If this is the method you want to
use, see “To create an Ethernet connection to a network.”

To create a modem connection to a network
1. Get the following information from your network administrator: dial-up access telephone

number, user name, password, domain name, and TCP/IP settings.
2. Insert a modem card into your Pocket PC, or connect an external modem to your Pocket PC

through the serial port using a NULL modem cable and appropri ate adapters.
3. Tap  and then Settings. On the Connections tab, tap Modem.
4. Tap New connection.
5. Enter a name for the connection, such as “Company Connection.”
6. In the Select a modem list, select your modem type. If your modem type does not appear, try

reinserting the modem card. If you are using an external modem that is connected to your
Pocket PC with a cable, select Hayes Compatible on COM1.

7. You should not need to change any settings in Advanced. Most servers now use a server-
assigned address. If the server you are connecting to does not use a server-assigned address,
tap Advanced and then the TCP/IP tab and enter the address. When finished, tap OK and then
Next.

8. Enter the access phone number, and tap Next.
9. Select other desired options, and tap Finish.
10.On the Dialing tab, specify your current location and phone type (most phone lines are tone).

These settings will apply to all connections you create.
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Once you have created the connection, it appears in , Programs, Connections. To start the
connection, remove your Pocket PC from the cradle or disconnect the cable, tap the connection
icon, enter your user name, domain, and password, and tap Connect. Once connected, you can:
• Send and receive e-mail messages by using Inbox. Before you can use Inbox, you need to

provide the information it needs to communicate with the e-mail server. For specific
instructions, see “Connect Directly to an E-mail Server,” later in this chapter.

• Visit Internet or intranet Web pages by using Pocket Internet Explorer. You may need to set up
a proxy server to visit Internet Web pages. For more information on setting up a proxy server,
see Pocket Internet Explorer Help on the Pocket PC.

• Synchronize. For more information, see ActiveSync Help on the desktop computer.

To create an Ethernet connection to a network
You do not need to create a new connection on your Pocket PC. Instead, you must purchase and
configure an Ethernet card that is compatible with your Pocket PC.
1. Get the following information from your network administrator: user name, password, and

domain name.
2. Insert the Ethernet card into your Pocket PC. For instructions on inserting and using the

Ethernet card, see the owner’s manual for the card.
3. The first time you insert the card, Network Settings will appear automatically so that you can

configure the Ethernet card. Most networks use DHCP, so you should not have to change these
settings unless your network administrator instructs you to do so. Tap OK. (If it does not
appear or to change settings later, tap  and then Settings. On the Connections tab, tap
Network and then the adapter you want to change.)

4. Connect the Ethernet card to the network by using a network cable. For information, see your
owner’s manual.

5. If you want to synchronize your Pocket PC, tap , and then Programs. Tap the Connections
folder, and then ActiveSync. Select Network Connection as the connection method and then
tap Connect. Remote synchronization with a desktop computer will work only if you have set
up a partnership with that computer through ActiveSync and have set ActiveSync to allow
remote connections. Other restrictions apply. For more information on synchronizing remotely,
see ActiveSync Help on the desktop computer.

6. If you want to access your e-mail server or the intranet, tap  and then Settings. On the
Connections tab, tap Network and then the Identification tab. Enter your user information. If
you need assistance, see your network administrator.

Once connected, you can do the same activities as listed in the preceding section.

End a Connection
If you started the connection from a program, such as Inbox or Pocket Internet Explorer,
disconnect from that program first. Then, tap  and then Today. Tap  or  at the bottom of
the screen and then Disconnect. To end a network connection, remove the card from your Pocket
PC.



56

Connect Directly to an E-mail Server
You can set up a connection to an e-mail server so that you can send and receive e-mail messages
by using a modem or network connection and Inbox on your Pocket PC.

The ISP or network must use a POP3 or IMAP4 e-mail server and an SMTP gateway.
Inbox does not currently support connecting with proprietary e-mail protocols, such as
AOL and MSN™. However, you can still access the Internet through these services. There
may be third-party programs available that would enable you to send and receive e-mail
messages through proprietary protocols.

You can use multiple e-mail services to receive your messages. For each e-mail service you intend
to use, first set up and name the e-mail service. If you use the same service to connect to different
mailboxes, set up and name each mailbox connection.

To set up a e-mail service
1. In Inbox on your Pocket PC, tap Services, and then New Service.

2. Select POP3 or IMAP4 as the service type, name the service, and tap Next. For information on
which service type to select, ask your ISP or network administrator.

3. If you have created a connection you want to use, select it from the Connection list. If you
have not, select Create new connection and follow the steps in the wizard. When you return
to this screen at the end of the wizard, select the connection you created from the Connection
list.

A wizard will walk you through the remaining steps. For an explanation of a screen, tap  and
then Help. When finished, tap Services and then Connect to connect to your e-mail server. For
more information on using the Inbox program, see “Inbox: Sending and Receiving E-mail
Messages” in Chapter 4.
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Get Help on Connecting
More information on the procedures described here, as well as information on additional
procedures, can be found in the following locations.
• “Inbox: Sending and Receiving E-mail Messages” in Chapter 4.
• Online Help on the Pocket PC. Tap  and then Help. Tap View, All Installed Help, and then

Inbox or Connections.
• ActiveSync Help on the desktop computer. In ActiveSync, click Microsoft ActiveSync Help

on the Help menu.
• Appendix B: Troubleshooting.
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Appendix A: Character Recognizer
Using Character Recognizer, you can write characters directly on your Pocket PC screen with
your stylus, just as you would on a piece of paper. The characters you write are translated into
typed text. Use Character Recognizer anywhere you want to enter text, for example, to write a
note or to fill in fields in a dialog box.
The default writing mode for Character Recognizer is lowercase (Jot-compatible) mode. In this
mode, you write characters in lowercase. The chart at the end of this appendix contains examples
of how to write characters in lowercase mode. You can also choose to write in uppercase (Graffiti-
compatible) mode. In this mode, you write characters in uppercase. If you prefer to write in
uppercase mode, tap Uppercase Mode in Options on the input method menu. Whether a letter
appears in uppercase or lowercase when it is converted to typed text depends on where in the
input panel you write it, not on the mode you have selected.
The Character Recognizer input panel is divided into three writing areas. Letters written in the left
area (labeled ABC) creates uppercase letters, and letters written in the middle area (labeled abc)
creates lowercase letters. Use the right area (labeled 123) for writing numbers, symbols, special
characters, and punctuation.

The letter you write is converted to typed text that appears on the screen.

Tap to show or hide the input panel.

Tap to select an input method or change options.

The following chart is a partial display of the characters you can write while in lowercase mode
(the dot on each character is the starting point for writing). Remember that even though you write
a letter in its lowercase form, the case of the text that is displayed depends on where you write the
letter. For example, if you write a lowercase “a” in the ABC area, an uppercase “A” is displayed
on the screen.
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For more information on using Character Recognizer and for demos of all characters, tap 
cricon on the Character Recognizer input panel.
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Appendix B: Troubleshooting

Reset the Pocket PC and clear memory

To reset the Pocket PC
If your Pocket PC responds slowly, stops responding as expected, or “freezes,” try resetting it. A
reset causes the Pocket PC to restart and re-adjust memory allocation. Unsaved data in open
windows may be lost.
• Use the stylus to press and hold the Reset button for about two seconds.

To clear memory
If you forget your Pocket PC password or want to clear all data from your Pocket PC and return it
to the factory settings, clear memory.

Warning: Clearing memory deletes all data and restores the Pocket PC to its default settings.
Programs installed at the factory remain, while data you have created and programs you have
installed are erased.
1. Turn the Pocket PC on.
2. Press and hold the Power button, and use the stylus to press and hold the Reset button for

about two seconds.
3. If a message appears on the screen, confirm that you want to clear memory.
-or-

Remove the main and backup batteries, wait 5 minutes, and then reinsert them.

Use ActiveSync to keep a backup of your Pocket PC data so that if you need to clear
memory, you can restore the data on your Pocket PC. For more information, see
ActiveSync Help.

Batteries lose power
When batteries are low, you will see a battery icon in the status bar of the Today screen. Replace
or recharge low batteries as soon as possible. When main battery is discharged, your data will be
preserved by the backup battery. If the backup battery is low, you run the risk of losing the data on
your Pocket PC.
You want your Pocket PC battery charge to last as long as possible, especially when you’re on the
road. Under normal conditions, you can get many hours of use from a single set of batteries or
from a full charge. Here are a few tips to help you get the most from them.

Use external power whenever possible
Use the AC adapter to plug your Pocket PC into external power whenever possible, especially
when:
• Establishing a remote connection (some modems use a lot of power).
• Using the backlight feature of your Pocket PC display.
• Connecting to a desktop computer.
• Letting the notification light flash for extended periods.
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Shorten auto-suspend time
While on battery power, your Pocket PC automatically suspends operation if you haven’t touched
the hardware buttons or used the stylus for a specified period. Maximize battery life by shortening
the time. Tap  and then Settings. On the System tab, tap Power, and then adjust the On battery
power setting.

Turn off sounds you don’t need
The Pocket PC produces sounds in response to a number of events, such as warnings,
appointments, and screen taps or hardware-button presses. To optimize battery life, turn off any
sounds you don’t need. Tap  and then Settings. On the Personal tab, tap Sounds &
Reminders and clear check boxes on the Volume and Reminders tabs.

Turn off notification light
Tap  and then Settings. On the Personal tab, tap Sounds & Reminders. On the Reminders
tab, clear the Flash light for check box.

If you forget your password
If you forget your password, you’ll need to clear memory on the Pocket PC. See “Reset the
Pocket PC and clear memory,” earlier in this appendix.

If you run out of Pocket PC memory
Memory on your Pocket PC is shared between storage memory and program memory. Storage
memory is used to store the information you create and programs you install. Program memory is
used to run programs on your Pocket PC. The Pocket PC automatically manages the allocation
between storage and program memory. However, in some situations, such as when memory is
low, the Pocket PC may not be able to automatically adjust the allocation. If you receive a
message stating that storage or program memory is unavailable, try the following solutions.

Storage memory
• Move data to a storage card.

• Tap , Programs, and then File Explorer. Tap and hold the file you want to move, and tap
Cut. Browse to the My Documents folder in the storage card folder, tap Edit, and then tap
Paste. Files stored in folders other than My Documents or stored in subfolders within
subfolders in My Documents may not show up in the list view of some programs. When
using Notes, Pocket Word, or Pocket Excel, you can also move files by opening the item and
tapping Tools or Edit and then Rename/Move.

• Move e-mail attachments. In Inbox, tap Tools and then Options. On the Storage tab, select
Store attachments on storage card. All attachments are moved to the storage card, and new
attachments are automatically stored on the storage card.

• Set programs such as Notes, Pocket Word, and Pocket Excel to automatically save new items
on the storage card. In the program, tap Tools and then Options.

• If you are copying files from your desktop computer or another Pocket PC to your Pocket PC,
try adjusting the slider in the Memory setting. Tap  and then Settings. On the System tab,
tap Memory and check whether the slider can be adjusted manually before copying files.

• Delete unnecessary files. Tap , Programs, and then File Explorer. Tap and hold the file,
and then tap Delete on the pop-up menu. To find your largest files, tap  and then Find. In
the Type list, tap Larger than 64 KB, and then tap Go.
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• In Internet Explorer options, delete all files and clear history. In Internet Explorer, tap Tools
and then Options. Tap Delete Files and Clear History.

• Remove programs you no longer use. Tap  and then Settings. On the System tab, tap
Remove Programs. Tap the program you want to remove and then Remove.

• Clear program memory as described in the following section. This will free some program
memory so that it can be allocated to storage memory.

Program memory
• Stop programs you are not currently using. In most cases, programs automatically stop to free

needed memory. However, in some situations, such as when confirmation dialog boxes are
waiting for a user response, the program may not be able to automatically stop. To check the
state of your active programs, tap  and then Settings. On the System tab, tap Memory and
then the Running Programs tab. Tap the program you want to view and then tap Activate.
Close any open windows or messages and return the program to list view. If this doesn’t work,
you can stop the program manually. First, make sure that your work is saved by closing open
items and returning the program to list view. Then, stop the program by tapping Stop or Stop
All on the Running Programs tab.

• Clear storage memory as described in the preceding section. This will free some storage
memory so that it can be allocated to program memory.

• Reset your Pocket PC, as described in “Reset the Pocket PC and clear memory,” earlier in this
appendix.

Screen freezes or responds slowly
Reset your Pocket PC. See “Reset the Pocket PC and clear memory,” earlier in this appendix.

Screen is blank
If the Pocket PC doesn’t respond when you briefly press the Power button, press and hold the
button for a full second. If that doesn’t work:
• Make sure your battery cover is locked and all expansion slots are secured.
• Plug the Pocket PC into AC power.
• Change or recharge the main batteries and backup battery.
• Adjust the display brightness. While holding down the Action control, press right or left cursor

buttons to adjust the brightness.
• Adjust the display contrast. While holding down the Action control, press up or down cursor

buttons to adjust the contrast.
• Reset the Pocket PC. See “Reset the Pocket PC and clear memory” earlier in this appendix.

Screen is dark
Prolonged exposure to direct sunlight may cause your Pocket PC screen to temporarily darken.
This is normal for LCD screens and is not permanent.
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Screen is hard to read
Pocket PC screens without backlighting can be hard to read under reduced light. Position a lamp
so that the light shines directly on the screen.
If you’re having a hard time viewing a document in Notes, try changing the size of the view. To
do this, tap a zoom percentage on the Tools menu. In Pocket Word and Pocket Excel, on the View
menu, tap Zoom and then select a zoom percentage. In Pocket Internet Explorer, on the View
menu, tap Text Size and then select a size.
If you’re having a hard time viewing Pocket Outlook data, try enlarging the display font. To do
this within Calendar, Tasks, or Contacts, tap Tools, then Options, and then select Use large font.

Inaccurate response to stylus taps
Adjust the touch screen to respond more accurately to screen taps. Tap  and then Settings. On
the System tab, tap Align Screen. You can also launch the touch screen alignment procedure by
holding down the Power button and pressing the Action control.

Slow or no response
Reset the Pocket PC. See “Reset the Pocket PC and clear memory,” earlier in this appendix.

Infrared (IR) connection problems
If you are unable to use IR to transfer information, try the following:
• Transfer only one file or no more than 25 contact cards at a time.
• Orient the IR ports so there is a straight, unobstructed path between, and so they are no further

than 20cm apart.
• Make sure nothing is between the two IR ports.
• Adjust the room lighting. Some types of light interfere with IR connections. Try moving to a

different location or turning off some lights.

Modem connection problems
You may encounter the following problems when using a modem. Additional troubleshooting
information is available in Connections Help on the Pocket PC and ActiveSync Help on the
desktop computer.

Can’t dial out
• Remove your Pocket PC from the cradle or disconnect the cable. You cannot connect using a

modem if your Pocket PC has an active connection with the desktop computer.
• Verify that the modem is firmly seated and connected to your Pocket PC and the telephone

jack.
• Make sure the telephone line is analog. (Analog telephone lines transmit data in analog instead

of digital form. Your home telephone line is most likely analog, while office telephone lines are
often digital.)

• If you create a modem connection for an external modem, select Hayes Compatible on COM1
as your modem. If you are using a modem card, select the modem card as your modem.

• To use an external modem, you need to use a NULL modem cable and appropriate adapters to
connect the external modem to your Pocket PC.

• Make sure the modem is waiting for a dial tone. Tap  and then Settings. On the
Connections tab, tap Modem. Tap your connection and tap Next twice. Make sure Wait for
dial tone before dialing is selected.
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• For international calls, allow more time for the call to go through. Tap  and then Settings.
On the Connections tab, tap Modem. Tap your connection and tap Next twice. Clear Cancel
the call if not connected within or increase the number of seconds allowed. For information
on dialing patterns, see Connections Help on the Pocket PC.

Can dial out but can’t make a proper connection
• Make sure the network to which you are trying to connect supports the Point-to-Point Protocol

(PPP). Your Internet service provider or network administrator can verify this.
• Verify that the location is correct. Tap  and then Settings. On the Connections tab, tap

Modem. On the Dialing tab, make sure that Location reflects your current location. Tap
Dialing Patterns to make sure the correct sequence of numbers is being dialed. For
information on dialing patterns, see Connections Help on the Pocket PC.

• Verify that you are using the right phone number for the modem you are trying to reach Tap 
and then Settings. On the Connections tab, tap Modem. Tap the connection and then Next and
double-check the phone number you are trying to reach.

Connection is unreliable
• Make sure the modem is firmly seated and connected to your Pocket PC and the telephone jack.
• Disable call waiting. Tap  and then Settings. On the Connections tab, tap Modem. On the

Dialing tab, select Disable call waiting. Then enter the disable code specified by your
telephone company.

Network connection problems
The following solutions may help if you encounter problems when using a network card for
network connections. Additional troubleshooting information is available in Connections Help on
the Pocket PC and ActiveSync Help on the desktop computer.
• Verify that you have an Ethernet card that is compatible with your Pocket PC.
• Verify that you have added necessary server information. Tap  and then Settings. On the

Connections tab, tap Network. Tap your installed adapter (usually your Ethernet card’s name)
and enter any necessary information. Most networks use DHCP, so you should not have to
change these settings unless your network administrator instructs you to do so.

• If Network Connection isn’t listed as a connection method in the ActiveSync dialog box when
starting synchronization, wait a few minutes and try again. Also, if synchronization does not
start right away, the network is probably busy, and it may take a minute for your Pocket PC to
connect to the network.

• Make sure that the proper drivers for your card are installed on the Pocket PC. For more
information, see the owner’s manual for the network card.

• Verify with your network administrator that your user name and password are correct.
• Verify with your network administrator that the network you are trying to connect to is

available, or try to connect to it from another computer.
• You may need to change the Pocket PC name if you are trying to connect to a network and

cannot because another Pocket PC with the same name is already connected. To change the
Pocket PC name, tap  and then Settings. On the System tab, tap About, and then the Pocket
PC ID tab.
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Cable and cradle connection problems
The following solutions may help if you encounter problems when connecting to your desktop
computer. Additional troubleshooting information is available in Connections Help on the Pocket
PC and ActiveSync Help on the desktop computer.
• Ensure the Pocket PC is turned on.
• If a modem or Ethernet card is inserted into your Pocket PC, remove it.
• Ensure that you do not have any other active connections. Tap  and then Today. Tap  or

 at the bottom of the screen and then Disconnect.
• Ensure the cable is securely plugged into the COM port or USB port on your desktop computer.

Use the cable that came with the Pocket PC without any extra cables or extenders attached.
• Plug the other end of the cable securely into the correct port on your Pocket PC. If you are

using a cradle, push your Pocket PC securely into the cradle.
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